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DPOAE Measurements with the RZ6

Introduction

This guide is primarily intended for researchers who are new to collecting DPOAEs using a TDT

RZ6/BioSigRZ system. It brings together targeted information from our software and hardware

manuals and goes beyond product specific details to answer common questions, including

subject or test area considerations that might affect your testing. The information provided is

based on our knowledge of the TDT system and years of experience helping our users. It's not

intended to favor or dictate any particular experimental protocols, methods, or research goals.

We leave the science up to you,  but  we're here to support  you on your way to successful

experiment completion.

Organization of the Guide

This guide begins with a general overview of DPOAEs; what they are, how they're used, and

what type of response signal to expect. It discusses the various aspects of your experiment

such as test subjects, your test area, and the hardware and software you will use. 

It includes detailed information about important tasks including:

Running the DPOAE

Viewing and exporting test results

System calibration

DPOAE Overview

Distortion  product  otoacoustic emissions (DPOAE)  are  generated  in  the  cochlea  when the

outer  hair  cells  amplify  and  propagate  particular  sounds  along  the  basilar  membrane  in

response to two tones separated by a fixed ratio and played from separate sound sources (or

speakers). DPOAE can be measured from the external auditory canal, making them an efficient

screening and diagnostic tool in the study of hearing and hearing loss. Researchers who study

DPOAE are interested in the energy or power of the Distortion Product as a function of the

power of the sound sources.

• 

• 

• 
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DPOAE Ear Diagram

The test stimulates the cochlea using two simultaneous continuous pure tones (F1 and F2)

from separate sound sources and that differ by 20%, or you can say they have a frequency ratio

(FR) of 1.2. As depicted in the DPOAE Ear Diagram above, the response from the cochlea is

continuous during the stimulation. A microphone is enclosed with the speaker tubes in the ear

canal.  It  records  the  sound pressure  changes  in  the  ear  canal  and  streams a  continuous

voltage back to the recording system. The microphone detects all signals present in the ear

canal. This includes both stimulation tones generated by the speakers, background noise, and

any DPOAE response waveforms generated by the cochlea, all summed together.

Averaged DPOAE Response Waveforms
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Standard DPOAEs measure the levels of the stimulation tones and the level of the cochlea

response,  which  is  one  of  many  generated  during  stimulation.  A  harmonic  is  a  frequency

component of a signal that is an integral multiple of the signal's fundamental frequency. To

separate  out  the  energy  of  these  unique  frequencies  (two  tones  and  a  harmonic  cochlea

response), the Time Domain signal is converted to a frequency domain signal that displays the

amount of energy each frequency contributes to the acquired waveform. When we isolate the

information we're looking for we can easily compare responses. The DPOAE measurements

are repeated a number of times and averaged together into the final frequency domain plot for

a desired stimulation level and frequency combination.

We know the F1 and F2 signals that we stimulate at, so we can easily find these on the x-axis

and mark  their  y-axis  levels  on  the  plot.  We also  know the  frequency  that  we expect  the

cochlea to respond at, so we can mark that level as well. Marking these frequencies and levels

across various stimulation frequency combinations forms a DP-gram. Some researchers are

also  interested  in  varying  the  stimulation  levels.  As  the  stimulus  levels  are  reduced  the

response is also reduced. The DP-gram shows the 'threshold' or the point where the DP can no

longer be detected from the noise of the microphone.

DPOAE Recordings

The TDT system for DPOAE recording features the RZ6 processor that brings together stimulus

production and data collection on a single device and under a single clock for precise timing.

The BioSigRZ system software for experiment control and data visualization is PC based and

is more flexible than clinical systems while still easy to use. DPOAE recordings do not need a

quiet  environment.  You  can  easily  record  DPOAE  on  a  bench  without  sound  attenuating

chambers, but this is optional.

The diagram below shows a typical DPOAE system. Each part of the system will be discussed

in more detail as you read through this guide.

Values  in  BioSigRZ  are  inherently  dBV.  You  can  convert  this  in  the  Acquisition  settings  or,  for  a  quick

approximation of the dB SPL value, you can add 120. Also see Converting dBV to dB SPL.

Note
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Typical System Using TDT's RZ6 Processor and MF1 Speakers

What you'll need:

Windows computer (WS4 shown)

Optibit interface (installed in computer)

TDT Drivers (software installed on computer)

BioSigRZ (software installed on computer)

Computer monitor

Multi I/O Processor with optic port (RZ6-A-P1)

TDT microphone system (DPM1)

Speaker (MF1)*

Speaker (MF1)*

Calibration microphone (PCB-378C01) (not shown)

Cable kit (BNC-ABR)

Sound attenuating subject enclosure (optional)

Heating pad (optional)

Subject

Anesthesia (not shown)

1. 

2. 

3. 

4. 

5. 

6. 

7. 

8. 

9. 

10. 

11. 

12. 

13. 

14. 

15. 

* EC1 Electrostatic speakers may also be used for higher frequency studies.

Note
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The Subject

Planning  or  setting  up  your  DPOAE  experiment  must  begin  with  an  understanding  of  the

subject's  normal  hearing  range  and  factors  that  might  have  an  effect  on  its  response  or

recording. DPOAEs have been measured for many species. In this guide, we'll  focus on the

three common species used in DPOAE experiments and screening protocols: mice and rats.

Expected Hearing Range

DPOAE tests are typically focused on the range in which the species is commonly known to

hear well.

Subject Standard Testing Range Standard Testing Range

Mice 4 kHz to 110 kHz 4 kHz to 48 kHz

Rats 2 kHz to 70 kHz 2 kHz to 32 kHz

(EC1: 4 kHz to 70 kHz)

The hearing range of laboratory subjects may vary across different strains or colonies and can be affected by age,

the environment, and anesthesia.

Note
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Age-Related Effects on Hearing

Many lab subjects experience hearing loss due to age. The rate of loss varies across species

and strains. This effect has been observed as early as 12 weeks in mice.

Anesthesia Considerations

Two types of anesthesia protocols are typically used for DPOAE testing. Each has benefits and

limitations. Check your IRB approved guidelines for dosages and protocol.

Xylazine(XYL) + Ketamine to start, Ketamine to Boost

This  aesthetic  protocol  uses  an  injectable  combination  of  muscle  relaxer  and  sedative.

Typically,  the subject is unconscious in a few minutes, begins to wake ~45 minutes and is

completely awake at ~90 minutes after initial sedation. If a subject wakes early or a test runs

longer than ~45 minutes, a booster of ketamine can be used to keep the subject anesthetized.

Be sure to follow your approved IRB protocol.

Isoflurane (ISO)

This  aesthetic  protocol  uses  a  fast  acting  inhalant  with  a  short  duration.  The  subject  is

typically fully sedated within 4-5 minutes and wakes very quickly when the gas is removed.

While ISO affects the central nervous system it does not appear to affect the peripheral system, such as hair cells.

Note
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Your Test Area

DPOAES  may  be  susceptible  to  ambient  noise  and  rely  heavily  on  good  positioning  of

microphone and ear tubes. Shaking or other mechanical movement can dislodge these items,

causing gaps to open in the signal path and degrading the signal quality. It is good practice to

minimize noise in the test area and to ensure all  conditions are carefully controlled during

testing. Be sure to consider the elements detailed below in setting up your testing area.

Enclosure Considerations

A sound attenuating chamber and Faraday cage are not required for DPOAE testing, but can be

used in excessively noisy environments.

Heating Pads

When the subject is sedated for testing, it generates less body heat and core temperature can

drop. When the subject loses body heat, its hearing system is not as responsive which can

artificially raise hearing thresholds (and reduce measured DP). A heating pad can be used to

maintain the subject's temperature.

Below are two alternative types of heating pads used for this purpose:

An Isothermal Pad contains a phase change material that changes state near the subject's

body  temperature.  It  can  be  heated  in  a  microwave  and  can  typically  hold  a  constant

temperature for an hour or more.

Example:  https://www.braintreesci.com/temperature-measurement-control/deltaphase-

isothermal-pads/deltaphase-isothermal-pads-8-x-8/

A Warm Water Recirculator moves warm fluid through a small subject heating pad to keep the

subject's body temperatures stable. Because this method uses an external heating element

Unlike ABR recordings, DPOAE recordings are not influenced by Electromagnetic noise.

Note
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and  pump  to  transfer  water  to  the  pad  via  non-ferrous  tubes,  the  recordings  will  not  be

affected.

Examples:  https://www.braintreesci.com/temperature-measurement-control/heat-therapy-

pumps-pads/adroit-heat-therapy-pump/ and  https://www.braintreesci.com/temperature-

measurement-control/heat-therapy-pumps-pads/gaymar-heating-cooling-t-pump-back-in-

stock/

Speaker Placement

To minimize the effects of distortion or interference, keep ear tubes short to minimize bending

and prevent  crimping.  TDT recommends positioning the subject  on it's  side and mounting

stimulus speakers directly above the subject's ear- allowing for tube lengths of 3 - 5 cm and

repositioning or turning speakers as needed rather than bending ear tubes.
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The Test Equipment

The care used in setting up your test area must also be taken when selecting and setting up

your test equipment.  TDT's DPOAE system is part of a modular experiment platform. Each

module in the system is designed for exceptional signal fidelity, precise timing, low noise, and

ease of use.

The sub-sections below discuss the role each part of the system plays in running a DPOAE

experiment and provides information on making the necessary connections.

DPM1

The DPM1 is a DPOAE microphone system manufactured by TDT. It can detect low intensity

signals in the range of 0 Db SPL. It can detect signals out to about 40 kHz.

The provided cable and Ear Tip carry the response from the microphone into the system via a

front panel BNC output.

The microphone tip also has two small tube-connectors to carry the stimuli to the subject's ear.

Slide the closed-field speaker tubes over these small stainless steel tubes, ensuring a snug fit.
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See Speaker Placement for information on how to position the ear tip.

Speakers

TDT's MF1 Multi-Field Magnetic Speakers are suitable for testing in the hearing range of mice

and rats. They should be configured for Closed Field for DPOAE testing (see Configuring the

MF1 for Closed Field Operation). Each MF1 comes with a tapered tube tip that mates with the

provided ⅛"  outside diameter  PVC tubing (10 cm included).  Always use the shortest  tube

possible to avoid bending or crimping. You can cut the tube to the desired length, typically 3-5

cm.  The  tube  should  slide  snugly  into  the  tube  tip.  You  can  push  firmly  without  fear  of

damaging the tube. If you have trouble inserting the tube, spray a small amount of silicone

lightly on a cloth, then put the tip of the tube on the cloth to apply it.

Check Ear Tip for obstructions before using. It can become plugged with debris from the subject, reducing the

measured DP.

Note

Other  lubricants  (WD-40,  grease  sprays,  or  similar)  should  not  be  used  as  they  can  damage  the  O-rings

surrounding the tube tip, or the tubes themselves.

Warning
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The MF1 comes with an inline filter  (pictured to the left  of  speaker,  above)  that  connects

between the RCA cable and speaker input. This filter should always be in place when using the

MF1 speakers in closed-field mode. In this mode, the MF1 has undesirably high, low-frequency

output. This filter reduces the speaker output at low frequencies so that the output range can

be equalized.

Each  MF1  has  a  built-in  8-32  threaded  hole  for  use  with  standard  laboratory  mounting

hardware. Some mounting hardware is included with the MF1.

RZ6 Signal Processor

The RZ6 Multi I/O Processor provides the processing power for averaging signal inputs and the

digital-to-analog  converters  and  amplifiers  for  producing  the  stimuli.  It  also  provides  the

precise  timing  essential  to  evoked  response  experiments.  The  power  input  and  optical

connection to the PC are located on the back. The input/output support  (such as speaker

drivers) and attenuation that is incorporated into the device are all accessed on the front panel.

Stimulus Output

The RZ6 can generate a stimulus in the frequency range of DC - 88 kHz and is well suited for

standard DPOAE testing.

A built-in stereo power amplifier drives the stimulus signals through TDT's MF1 multi-function

speakers via the BNCs labeled Out-A and Out-B.

Use RCA - BNC cables (included with the MF1 kit), or BNC to RCA adapters, to connect OUT-A

and OUT-B to the RCA connectors on the speakers.

The EC1, Closed-Field Electrostatic Speakers can be used for higher frequency studies.

Note
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When using the MF1s, the ON/OFF switch next to the outputs marked Electrostatic must be in the OFF position to

reduce noise.

If using EC1 speakers, the ON/OFF switch next to the outputs marked Electrostatic must be in the ON position.

Important
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Attenuation

Typically,  stimulus attenuation is  handled via  software.  The Atten knob on the front  panel

provides optional  manual attenuation applied to the signal  before it  is output.  This can be

useful if the sound level is found to be systematically too high across all frequencies during

speaker calibration. See DPOAE Calibration.

Mic Inputs

Connect the DPM1 Out to the Microphone In-A BNC input connector. No gain is required for

the signal, so the AMP/BYP switch must be set to BYP.
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PC and Interface

The RZ6 must be directly connected to a PC, which provides the user interface for the system.

The PO5 or PO5e optical interface card is installed in the PC and connected to the RZ6 across

fiber optic cables. This adds another layer of noise reduction, isolating the processor from the

noisy PC environment.

The PC handles:

Configuring the hardware and software.

Communicating  with  the  TDT  hardware  and  transferring  data  across  a  fiber  optic

interface.

Displaying and working with data during and after acquisition.

If you use TDT's WS4 computer, the optical interface and BioSigRZ software are preinstalled.

If you use your own PC, you'll need to install the interface card and BioSigRZ software yourself.

Step-by-step instructions for installing software and drivers and setting up the processor are

available in the System 3 Install Guide that came with your system. The installation guide also

includes  information  for  connecting  the  WS4  or  your  PC  to  the  RZ6  Processor,  including

running a transfer test to ensure communication between them is working correctly.

• 

• 

• 
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A UZ3 (USB 3.0) interface is also available if you wish to use a laptop.

Note
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BioSigRZ Software

BioSigRZ software is streamlined and optimized for ABR and DPOAE screening. The software

provides a simplified interface for selecting stimuli and configuring how the response will be

recorded and processed.

DPOAE

Two  tones  are  typically  presented  at  multiple  frequencies  to  target  specific  areas  of  the

subject's hearing range.

Out-of-the-Box Experiments

When the software is installed, out-of-box an experiment file for DPOAEs is stored at:

C:\TDT\BioSigRZ\Configs\DPOAE

The default values used in the pre-configured experiment are set to values suited to typical

experiments. Your protocol or circumstance may differ from these values but these will work

as an example or a starting point and can be modified to fit the needs of your lab.

To open the DPOAE experiment configuration:

Launch BioSigRZ

Click the menu File → Open Config. File

Browse to and open the following file:

C:\TDT\BioSigRZ\Configs\DPOAE\Root_DPOAE.acf

Two tones that are about 20% apart will be presented continuously. Distortion-product data

will be collected every 20.971 milliseconds and averaged 512 times.

DPOAEs will be measured at the following center frequencies(Fc): 4000 Hz, 8000 Hz, 16000

Hz, and 32000 Hz. 

The tone frequencies will be F1 and F2, are calculated using the center frequency where F1

is Fc * 0.909 and F2 is Fc * 1.09. This yields frequencies of primary 1, named Tone 1, and

primary 2, named Tone 2, that are geometrically centered about Fc. 

1. 

2. 

3. 
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The Level of the two primary tones will remain equal and will vary with each frequency from

80 dB SPL to 20 dB SPL in 10 dB decrements.

This DPOAE test is designed to measure the level of the "cubic difference tone." which is at

2F1-F2.

The Stimulus Settings

The default stimulus settings represent a typical configuration and should be fine to begin, but

you may eventually want to make adjustments.

The stimulus setting dialog boxes can be opened by clicking Setup → Stimulus.
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The setting notes below provide information about each setting.

Setting Notes

Enable Ch2 Enabled

CH1 DPOAE1.sig

CH2 DPOAE2.sig

A complete list of signal parameters and variables from the .sig file are added to the

BioSigRZ configuration file. During stimulus presentation, the variables change as a function

of the SigGen Index (SGI), which is a set of variable conditions. The order of the presentation

is called the stimulus schedule. You can access this schedule and choose to omit specific

SGIs, if desired. See Modifying the Stimulus for more information on modifying the standard

protocol.

Speaker Calibration Leave blank for now

All speakers have some variation in output across frequencies. When you use a speaker with

a known frequency response, you can adjust the stimulus output for these known frequency

characteristics. A USB drive with a speaker-specific calibration file is provided with your MF1

speaker. You will need to copy that file to the following directory: C:\TDT\BioSigRZ\TCF .

After the file has been copied to this directory you will be able to select it from a list in the

Stimulus Channel Setup. You can also make your own .tcf calibration file by following the

instructions in BioSigRZ Manual

The first time you run a DPOAE, we recommend skipping this step and any other calibration

until after you have been able to successfully record a response. If the system has not yet

been fully tested, small mistakes in calibration can become more difficult to diagnose. It is

important to make sure everything else is working before calibrating.
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The Acquisition Settings

The default acquisition settings should be fine to begin, but you may eventually want to make

adjustments.

The acquisition settings dialog boxes can be opened by clicking Setup → Acquisition.

The setting notes below provide information about each setting.
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Auto Cursoring

The auto-cursor feature can place up to 10 cursors on each acquired trace as a mathematical

function of a variable or at a specific frequency. BioSigRZ supports automatic feature finding

to minimize the amount of manual cursor manipulation that has to be performed after data

acquisition.  Cursors  are  defined  from  the  Setup  menu,  Auto  Cursors  command.  Available

choices  include  features  such  as  peaks,  valleys,  zero-crossings,  absolute  positioning,  and

more. See the BioSigRZ Manual for more information on using Auto Cursor.

This experiment has auto-cursor pre-configured to mark F1, F2, and 2F1-F2 so they can be

easily viewed and extracted later for analysis. After DPOAEs are acquired, you can add or edit

cursors  in  the Edit  Cursor  window.  This  window is  opened when you double  click  a  trace

(waveform) in the History or Worksheet plot.

Setting Notes

Response Record File All the data collected and displayed in the History plot during the DPOAE test are stored in

a response record file (.arf). By default the file will be saved at: C:\TDT\BioSigRZ\

You can specify a name in the setup window or select the Prompt for File Name check

box to be prompted for a name before each recording session. You will be prompted each

time you click Begin.

Setup Inputs|Source Audio A/D

Number of Averages 128

You need enough responses to get good signal quality and few enough to minimize the

time to complete testing. For DPOAEs, the typical range is 64 - 128 averages.

Gain 1

The DPM1 microphone system connects directly to the RZ6 for acquisition. You must

also set the Amp/Bypass switch on the RZ6 face to BYP (bypass).

Microphone Calibration Choose the DPM1_600mV.tcf file that will match the history plot units to dB SPL. See 

Converting dBV to dB SPL for related information.
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Running the Experiment

After you feel comfortable with the system, you can begin to collect data. We recommend

reading through the entire guide before using a live subject.

Check Sedation

If  the  subject  is  not  fully  sedated  throughout  testing,  subject  responses,  such  as  muscle

movements or distress, can interfere with DPOAE recordings. To avoid this, always check the

subject before beginning your experiment and monitor the subject for signs of wakefulness

during testing.

Toe Pinch

For small lab subjects, a toe pinch is the most effective method to check for full sedation.

Extend the rear leg and use your fingernails to firmly pinch toe or foot webbing. There should

be no recoil. If there is any response, such as leg movement, the subject is not adequately

anesthetized.

Check Integrity of the Signal Path

Good positioning of microphone and ear tubes is critical to getting a useful recording of the

DPOAE response.

Check the positioning of  the DPM1's  Ear  Tip,  making sure  there  is  good fit,  with  no gaps

between the Ear Tip and the subject's ear. If the subject's ear is too small for good positioning,

a pipet tip can be used to step down from the size of the Ear Tip into the subject's ear.

Startling the subject with a loud clap or loud noise is not a rigorous enough way to check sedation. A subject may

not respond to clapping even when only partially sedated. Also, a test subject with hearing loss may not respond

regardless of sedation level.

Note
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Ear Tip

Length (L) should be as small as possible.

Inner Diameter (ID) should be as big as possible.

Check the seal of the clear tubes at the MF1 tube-tip and at the DPM1 Ear Tip. The clear tube

should slide snugly into the tube tip and snugly onto the Ear Tip's stainless steel input tubes.

Check the tubes to make sure they are as straight as possible and they are not crushed or

crimped.

Make sure the in-line filters provided with the MF1 speakers are connected between each MF1

and the cable that connects it to the RZ6.

Begin Experiment

BioSigRZ  is  the  user  interface  for  DPOAE  testing.  It  has  three  modes  of  operation:  Idle,

Running,  and  Averaging.  Before  you  begin,  it  is  in  Idle  mode.  You  can  begin  stimulus

presentation or run the experiment using buttons on the left side of the BioSigRZ software

main window. The options change depending on the mode. See below for more information

about the operating modes.

Running the Experiment | 27



To begin stimulus presentation:

Click the Start button. You may be prompted to specify a response record file where data will

be stored.

If prompted, type a name in the File Name field and click Open

You are now in Running Mode.

The stimulus signal is presented using the first SigGen Index (SGI) in the stimulus schedule.

No data is collected.

To begin data averaging:

Click the Begin button.

A Subject Information window opens. Information entered here is stored with the data in the

response record file (.arf).

Enter any subject information and click OK.

You are now in Averaging Mode.

The first stimulus is presented and the DPOAE response data is acquired and included in the

running average until the desired number of responses has been collected at that level. As

averages are completed, the averaged DPOAE records will be appended to the History plot and

the .arf data record file.

1. 

2. 

1. 

2. 

3. 
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Modifying the Stimulus Schedule

BioSigRZ provides several functions that allow you to override the current stimulus schedule

and control data averaging in real-time.

Advance Current SGI is halted and running average is saved. Stimulus presentation advances

to the next SGI in the stimulus schedule.

Repeat Current SGI is halted and running average is saved. Stimulus is presented again at the

current SGI.

Skip Current SGI is halted and running average is discarded. Stimulus presentation is advanced

to the next SGI in the stimulus schedule.

Redo Current SGI is halted and running average is discarded. Stimulus is presented again at

the current SGI.

Multi-Purpose Plot

During averaging, the Multi-Purpose Plot may be used to display a variety of signals. The plot is

controlled through the use of the Plot Control Toolbar, available from the right-click menu. You

can also control scaling using the toolbar. Consider using the options described below.

Running Avg This view displays the current running average in the frequency domain.

Zooming Click and drag from left to right over the area of interest to zoom in and change the

scale of the frequency axis. Click and drag from right to left to zoom out.
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Termination

In BioSgRZ, control of termination of the signal presentation and acquisition is called boundary

control. When a boundary is reached and the SGI stops incrementing, signal generation will

continue for the current SGI, but no more response data will be collected.

You can manually terminate data averaging at any time by clicking the End button. This returns

the system to Running mode.

You can halt stimulus presentation and return the system to Idle mode or run the experiment

again by clicking the Stop button.

Click Begin to run the experiment again and enter the new subject information.
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Data and Export

Viewing data in the BioSigRZ plots and worksheet.

History Plot

In  averaging mode,  BioSigRZ acquires data and calculates a running average.  Data will  be

acquired until enough records have been gathered to compute the final averaged signal. At that

time,  the averaged signal  will  be appended to the end of  the History  Plot,  the SGI  will  be

incremented,  a  new  stimulus  signal  will  be  generated  according  to  the  current  stimulus

parameters, and a new average will be computed. This process continues until the termination

of the stimulus schedule is reached or until  you manually  end data averaging.  Information

about each SGI is displayed to the left of the history plot (pictured below). Right-clicking this

data allows you to control what data is shown.
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The Worksheet

The worksheet provides you with several basic functions. It allows you to graphically organize

acquired data and perform mathematical and visualization manipulations of the acquired data

directly in BioSigRZ. The Worksheet is located to the right of the History plot. Waveforms can

be copied from the Worksheet and pasted to other applications for report writing or exported

by choosing to generate a report.

To place History Plot records into the Worksheet:

Select the desired record(s).

Click and drag the selected record(s) from the History Plot to the Worksheet.

The selected History Plot record(s) will be copied to the Worksheet.

To change the token (#1) that appears to the left of the trace:

Right-click the worksheet.

The Worksheet Preferences dialog is displayed. Select the desired parameter for Token #1

from the drop-down parameter list.

1. 

2. 

1. 

2. 
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Changes made here, will be applied to records added to the worksheet after this change is

made. To change existing tokens, click the Change All button to the left.

Other tokens can also be changed in this dialog.

Click OK, to apply the change.

For  more information on using the worksheet,  see the Using the Worksheet section of  the

BioSigRZ Manual.

Export Data

BioSigRZ has many onboard tools for viewing and working with responses. Records may be

exported to a CSV (spreadsheet) file or an ASCII text file (.txt file) or you can choose to do

further analysis in an environment such as Excel. We can provide support for exporting data to

the desired format, but we leave further analysis up to you so that you can do it your way.

To export to CSV:

Select the desired records in the History plot or worksheet.

On the Menu bar, click the corresponding menu (History or Worksheet) and click Export to

CSV file.

3. 

1. 

2. 
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The settings  shown are  the  typical/recommended  export  settings,  including  cursors,  for

DPOAEs. If you wish to further customize the export, click the check boxes or radio buttons

to toggle on/off the desired options.

To export the data points that constitute each trace, check the box next to Data Samples.

These data points can be used by MATLAB or Excel to recreate the exact trace shown in

BioSigRZ

Type a report title in the Title field.

Click the Generate Report button.

When prompted, specify a file name and location to store the export file and click the Save

button.

When you are  returned to  the  CSV File  Export  dialog  box,  you can change options  and

generate additional report exports or click Done to exit.

Selecting Trace Data check boxes will  also export the data needed to recreate the entire

trace as seen in BioSigRZ.

See the BioSigRZ Manual. for further information on data viewing tools and export features.

3. 

4. 

5. 
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Troubleshooting

Diagnosing Noise Issues

Noise DPOAE Response with Harmonics

The  image  above  shows  a  noisy  DPAOE  recording  that  contains  harmonics  (frequency

components of a signal that is an integral multiple of the signal's fundamental frequency) that

could easily be mistaken for the DPOAE response. If a frequency component is present when

no living subject is present, it is not the DPOAE response.

Here are a few common sources of noise:

Something near the recording area is causing noise.1. 
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The nearby area should be as free of mechanical vibration sources as possible. Common

sources  are  motors  and  fans,  refrigerators,  HVAC  systems,  elevators,  refuse  pumps,

centrifuges.

A tube is obstructed or there is a gap in the connections.

Length of tube is too short or too long.

Improper seal between ear and DPM1.

Battery is low, use DPM1 Battery Check tool to verify.

Troubleshooting On-The-Fly

If a problem occurs during an experiment,  the BioSigRZ Multi-Plot window provides several

views useful  for  on-the-fly troubleshooting.  Here are a few common problems that  can be

identified and resolved quickly so you can resume you're experiment.

The EEG view in allows you to monitor recordings during testing.

Cause: An animal that is awake or not fully sedated

You can also view a running average of the responses.

Cause: A speaker problem. Check the speaker by listening during stimulation.

Cause: A problem with the RZ6 or DPM1.

Cause: A hearing impaired animal. Check proper fit of Ear Tip and tubes.

Cause: A deaf animal. Try the test again on with a normal hearing animal.

Cause: An obstruction in the DPM1 Ear Tip.

2. 

3. 

4. 

5. 

Random jumps in signal level

Missing F1 or F2 peak

Missing F1 and F2 peaks

No DP at any SGI
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Cause: A noisy environment (fans, etc.) or low DPM1 battery. Check battery.

Getting Help

If  you  are  unable  to  diagnose  the  noise  problem,  contact  TDT  for  assistance  at

support@tdt.com or +1.386.462.9622.

When  you  contact  us  be  prepared  to  answer  questions  such  as,  what  frequencies  you're

testing, what subject and anesthetic you're using, and when the system was last calibrated. We

may also ask you for data, screen-shots, or photos of your experimental setup. We may also

ask you to participate in a remote desktop session, which requires an Internet connection to

your experiment PC running BioSigRZ software.

Noisy signal
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Calibration

All speakers have some variation in output across frequencies. When you use a speaker with a

known frequency response in BioSigRZ, you can adjust the stimulus output for these known

frequency characteristics by applying a Calibration File (.tcf) in the Stimulus Setup. You can

create custom files specifically for your speakers and setup, using BioSigRZ's Calibration tools.

During  calibration,  BioSigRZ  performs  a  sweep  over  the  frequency  range  of  interest  and

generates a speaker response curve along with a correction curve that would be required to

flatten the response. An FIR filter is calculated from the correction curve and stored in the

contents of the calibration file. When you load the calibration file, that filter is loaded onto the

RZ6 so that any tones presented through the RZ6 will be calibrated to have a flat response

across all frequencies.

The first time you run a DPOAE, we recommend skipping calibration until after you have been

able to successfully record a DPOAE response. If the system has not yet been fully tested,

using a custom calibration file can make problems more difficult to diagnose.

When you're  ready  to  tackle  calibration,  you  can  review the  BioSigRZ Manual.  It  covers  a

standard single channel speaker calibration. The remainder of this section covers important

details you'll need for calibrating your DPOAE setup.

DPOAE Calibration

DPOAE testing differs from other hearing tests in two key ways that affect calibration: it always

uses two channels and it's always closed-field.

Because the two stimulus tones (F1 and F2) are presented on separate channels, with two

different speakers, you will need two calibration files (.tcf), one for each of the two stimulus

speakers.

The closed-field nature of DPOAEs makes it even more important that you use calibration files

that are not only specific to your speakers, but specific to your setup. Tube length, curve, and

position in the ear can all affect the frequency characteristics of the delivered stimulus. TDT

recommends in-ear calibration, using your experiment setup, to get the best possible results.

An added benefit of this type of calibration is that it is a good test of the fit and seal of the

tubes and their positioning in the ear.
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Hardware Setup

For in-ear calibration, you must have everything set-up as you will for your experiment. That is,

your subject is sedated and the microphone is in the subject's ear.

In-Ear DPOAE Calibration Setup

The Amp/BYP switch on the front of the RZ6 will be set to BYP in most cases. In BYP (bypass)

mode, the Gain knob is not used and will not affect the signal.

Because you'll be creating and using two TCF files and it is critical to use the correct file for

each  speaker  when  you  begin  testing,  TDT  recommends  labeling  the  speakers  and  each

connection point (as pictured above, using 'A' and 'B' with colored stickers, polish, or paint) to

identify the speaker. Whatever labels you use can also be appended to the TCF file names to

distinguish between them.

Creating the Calibration Files in BioSigRZ

When  you're  ready  to  run  your  calibrations,  follow  the  instructions  in  Creating  a  Custom

Calibration (.tcf) File in the BioSigRZ Manual, with the following changes.

In the Calibration window under Microphone Calibration, select the DPM1_600mV.tcf file.

The A/B switch in the Probe area allows you to turn off one of the speakers while calibrating

the other. The first time you run through the calibration, set this switch to 'A'. Speaker 'B' will be

turned off, temporarily. When you're satisfied with the new calibration file you've made, be sure

to save it, using "A" in the name.
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Next, change the switch to 'B'. Do NOT change hardware connections. Speaker 'A' will be turned

off temporarily, so that speaker 'B' can be calibrated, with no changes to your setup. Run the

calibration again, and when you're satisfied with the new calibration file you've made, save it

with "B" in the name.

When you have created your two calibration files (.tcf), you can close the Calibration window.

Open the Setup and Stimulus menu and assign the newly created speaker-specific TCF files for

channels one and two.

You can use the calibration verification utility (also described in Testing the Calibration (TCF)

File, in the BioSigRZ Manual.

How Often to Calibrate

For DPOAE recordings, TDT recommends in-ear calibration for each subject. Please note that

the DPM1 is not a calibration microphone.

Testing Speakers and Microphones

A simple  RPvdsEx test  circuit  can be used to ensure your  speakers  and microphones are

working. The test circuit,  SpeakerMicTest.rcx ,  is part of the BioSigRZExamples.zip zipped

example folder, which can be downloaded from the TDT website.

Speaker Test

If you suspect that your speakers may not be functioning correctly, download and extract the

zipped files to:

C:\TDT\BioSigRZ\RCX

Then double-click the SpeakerMicTest.rcx  file to launch RPvdsEx and open the file.

To ensure accurate calibration, give the microphone 10 minutes to warm-up before testing.

Important
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To use this circuit there are a few steps required for setup:

Connect your speaker to Out-A.

RZ6 with MF1 Speaker

To test your speakers:

Click the Compile, Load, Run button on the toolbar. You should be able to hear a tone

from the speaker.

Click the Stop button to stop the test.

Repeat with second speaker.

Microphone Test

After you've confirmed at least one speaker is working, connect the calibration microphone

and run the circuit again.

1. 

To ensure accurate calibration, give the microphone 10 minutes to warm-up before testing.

Important
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RZ6 with MF1 Speaker and DPM1 Microphone

To use this circuit there are a few steps required for setup:

To use this circuit there are a few steps required for setup:

Connect your DPOAE Microphone to the In-A port on the RZ6.

Ensure your Amp/BYP switch on the front of the RZ6 is set to Bypass.

You should be able to see a sine wave in the graph in RPvdsEx. You may need to adjust the

scale using the green arrows on the sides of the graph. Click the Stop button again to stop the

test.

1. 

2. 
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Configuring MF1 for Closed Field

MF1 Closed Field Speaker Assembly Diagram

To configuring the MF1 for closed field operation:

Ensure Black O-ring is in place on back of CF Adapter, as shown.

Closed Field Adapter, Tip, and CF Line Filter used only for Closed Field Configuration!

Important

1. 

Front of Speaker Back of CF Adapter
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Attach the CF Adapter to the front of the speaker using three of the provided ¼ x 4-40 hex

screws.

Ensure the blue O-ring is in place at the base of the desired tip, as shown.

Insert the tip into the groove on the CF adapter. Ensure the tip is bottomed in its socket.

Gently insert the tube into the narrow end of the tip.

Attach the CF filter to the provided RCA cable.

CF Line Filter

Attach a BNC to RCA adapter to the BNC amplifier port of your source device.

2. 

Speaker with CF Adapter 3 mm Tube Tip with Blue O-Ring

3. 

4. 

For Closed Field Configuration Only

Important

5. 
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Back of Speaker (shown with included stand)

Connect the MF1 to the amplifier using the RCA cable (with CF filter attached).

For more information on the MF1 Speaker, see the System 3 Manual.

6. 
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Modifying the Stimulus

When the stimulus is defined, a complete list of signal parameters and variables are added to

the  BioSigRZ  file.  During  stimulus  presentation,  the  values  of  the  variables  change  as  a

function of the SGI. This is called the stimulus schedule.

You  may  wish  to  present  a  subset  of  the  current  stimulus  schedule.  Both  the  stimulus

schedule  and  the  variable  definitions  can  be  modified  in  BioSigRZ.  To  do  so,  display  the

stimulus  schedule  (as  below)  then  select  the  SGIs  to  be  included  in  the  subset  for

presentation.

To view the current stimulus schedule:

Select Modify Schedule from the Operations menu.

Or select SigGen Variables from the Setup menu.

Or click the Modify Schedule button.

• 

• 

• 

Modifying the Stimulus | 46



The SigGen Variable Control dialog displays the current stimulus schedule. Variable values are

shown for each SGI. Select SGIs to include in signal presentation by using standard Windows

techniques, such as click, SHIFT-click, and CTRL-click. You can also choose to 'Do Odd' or 'Do

Even', using buttons in the dialog box. When no SGIs are selected, BioSigRZ will present the

entire stimulus schedule. Otherwise, BioSigRZ will present only the selected SGIs.

Modifying Variables

The variables can also be modified to meet your needs.

To modify a variable:

Click the variable button for the desired variable, such as Freq.

In the Signal Variable dialog box, make any changes then click OK to confirm and return to

the SigGen Variable Control.

Different variables may have different editable options. For example, the variable frequency

for a tone stimulus may be configured by entering a Value List (shown below).

1. 

2. 
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The schedule tool was designed for quick edits you may want to make while testing or setting

up a new paradigm. For permanent edits to your stimulus, TDT recommends using SigGenRZ

(included with BioSigRZ installations) to modify the stimulus files (.sig) directly.

The changes will only be saved in the configuration file, if the Lock SigGen Files check box is selected in the

Stimulus Setup dialog bog. If  this check box is not selected,  any changes to variables or SGI selections for

presentation will be lost.

Also, if you select the Reload Files button in the Stimulus Channel Setup window, the changes will be overwritten

in favor of the values in the .sig file.

Important
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Customizing the Stimulus

SigGenRZ is a signal design software that enables you to create stimuli in a dialog box driven

environment.  Most  importantly,  it  allows  most  settings  to  be  used  as  variables  for  your

experiments. All of the signals used in the BioSigRZ out-of-the- box experiment configurations

have been created in SigGenRZ. It is also a helpful tool for modifying aspects of the stimulus

that are not editable from within BioSigRZ.

To modify a file directly in the SigGenRZ software you will need to follow these basic steps:

Open the stimulus file (.sig) in SigGenRZ.

Make changes in the file.

Save the file or save the file with a new name.

Open the desired BioSigRZ configuration file (.acf).

Load or reload the stimulus file.

Save the BioSigRZ configuration file.

Opening the File

The stimulus files (.sig) for the BioSigRZ out-of-the-box experiment configuration are stored at:

C:/TDT/BioSigRZ/SIG/

For DPOAEs there are two files: DPOAE1.sig and DPOAE2.sig.

It is generally a good idea to leave the original files unchanged and in place, but you can still

use and modify these files then rename the file.

To open the signal file you wish to modify:

Click the Start button on the Windows taskbar, point to Programs, point to TDT Sys 3, and

click SigGenRZ.

Select Open from the File menu.

Click the desired file name.

Click OK.

1. 

2. 

3. 

4. 

5. 

6. 

1. 

2. 

3. 

4. 

Modifying the Stimulus | 49



To save the file with a new name:

Select the signal by clicking anywhere in the signal window.

Choose Save As from the File menu.

The Save As dialog box will be displayed.

Type a new name for the signal and click OK.

SigGenRZ builds a signal from mini-signals called segments. The standard DPOAE stimuli have

only one segment. Some settings affect the entire signal while others affect only a segment.

The most common changes to the signal settings include Level, Frequency, F1, and F2. These

can be found in the Signal Parameters dialog box.

To open the Signal Parameters dialog box:

Click Signal from the Modify menu.

The most common changes to the segment parameters include: Gate Type,  Gate Time and

Duration.  Parameter  settings  that  define  the  segment  can  be  modified  in  the  Edit  Signal

Segments window.

To access the Edit Signal Segment window:

Select Modify → Segment menu option in the main window.

Or double-click the segment marker in the signal window.

1. 

2. 

3. 

4. 

• 

• 

• 

Modifying the Stimulus | 50



Converting dBV to dB SPL

The  RZ6 Processor  is  a  ±10  V  device  and  so  levels  described  in  BioSigRZ are  inherently

interpreted as dB Volts. When the microphone, which converts mechanical energy to a voltage,

is known; you can use the gain settings in the software to convert the dB Volts to display

values in dB SPL.

The Acquisition Settings section discusses where to apply this type of conversion.

For example, assume you have a peak of -70 dBV you'd like to convert. You can find the linear

voltage with V = 10^(dBV/20) and then compare this to the microphone response at 93.9 dB to

get a dB value relative to 93.9, and then add 93.9.

The TDT DPM1 microphone response at 93.9 dB is 0.6 V.

20 * log10(10^(dBV/20) / 0.6) + 93.9

For -70 dBV the output would be:

20 * log10(10^(-70/20) / 0.6) + 93.9 = 28.34 dB

Notice that the starting dBV value + 100 = 30, which is a close approximation to the actual value of 28.34 dB. So,

when you are viewing a plot that uses dBV, you can add 100 to the dBV value reach a quick approximation of the

dB SPL.

Tip
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